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This document describes new features, known limitations, issues, and fixes in Autodesk Entertainment 
Creation Suites 2013. It is strongly recommended that you read this document before you install this 
release. For reference, save these release notes to your hard drive or print a copy. 
 
These release notes address all 2013 versions of the Autodesk Entertainment Creation Suites, including 
the Standard, Premium, Ultimate, and educational versions. Some information in this document may 
show products not included with your suite. 
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Click the following links to view the Release Notes for each product: 

 Maya 2013 Release Notes 

 3ds Max 2013 Release Notes 

 Softimage 2013 Release Notes 

 MotionBuilder 2013 Release Notes 

 Mudbox 2013 Release Notes 

Additional Resources 

For complete instructions about uninstalling and installing Autodesk Entertainment Creation Suites 

2013, see: www.autodesk.com/me-install-2013-enu 

For licensing information, see: www.autodesk.com/me-licensing-2013-enu 

For system requirements, see: www.autodesk.com/systemrequirements-suites-2013 

For a network administration guide, see: www.autodesk.com/me-administrator-2013-enu 

For further resources, see: http://www.autodesk.com/entertainmentcreationsuites-documentation 

What’s New 

The following section describes the new features and enhancements in the Autodesk® Entertainment 
Creation Suites 2013. 

Maya to 3ds Max Interoperability Workflows 

Iterative workflows between Maya and 3ds Max can now be handled by clicking new items found in the 
application main menus.   

CAT to HIK / HIK to Existing CAT  

Using “File > Send to…” or FBX export, you can convert CAT bipedal characters into an HIK definition 
compatible with Maya and MotionBuilder. Animation is converted into an FK representation on the 
HumanIK defined skeleton.  

Remote Live Character Stream 

You can now drive your HumanIK defined character (skeleton or custom rig) in Maya with a remote 
source such as motion capture data coming from MotionBuilder. 

Unified Character Context 

This feature addresses HumanIK usability issues by consolidating all HumanIK tools into a single dynamic 
context and removes user complexity by simplifying and automating basic workflows. 

http://www.autodesk.com/maya-readme-2013-enu
http://www.autodesk.com/3dsmax-readme-2013-enu
http://www.autodesk.com/softimage-readme-2013-enu
http://www.autodesk.com/motionbuilder-readme-2013-enu
http://www.autodesk.com/mudbox-readme-2013-enu
http://www.autodesk.com/me-install-2013-enu
http://www.autodesk.com/me-licensing-2013-enu
http://www.autodesk.com/systemrequirements-suites-2013
http://www.autodesk.com/me-administrator-2013-enu
http://www.autodesk.com/entertainmentcreationsuites-documentation
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Custom Rig Mapping 

The new Custom Rig mapping tool lets you create a custom rig mapping definition and retarget 
animation using a UI similar to the Character Controls. 

Align Control Rig 

This improvement visually merges the IK and FK solutions together, showing only the final solving of the 
character's skeleton. 

Editable Character UI 

You can now customize the Character Controls UI (Full Body, Hands and Feet views), as well as the 
Custom Rig UI view by modifying an external XML file. 

Consistent F-Curve Editor 

Animation editors in Autodesk Entertainment Creation Suites packages are now more consistent with 
the way in which function curves (F-Curves) are manipulated by the user. 

Retime Tool 

This feature lets you adjust the timing of your animation quickly using new retime markers directly in 

the Graph Editor. 

Suite Interaction Mode 

Interaction mode provides a set of hotkey/keyboard shortcuts that are consistent across all products 
within the Suite. 

Suite Specific Functionality 

Some features are now exclusive to suites. These features require that you have a suite installation and 
a suite license to use them. (That is, the feature is not available in a stand-alone product, such as 
MotionBuilder, only the version of MotionBuilder that comes included with a suite.) 

Documentation Legend 

The following symbols appear in some of the Entertainment Creation Suites product documentation to 
indicate new and updated information, as well as conditions in which some of the features appear. 
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New 

The New symbol introduces a feature that is in the product for the first time.   

Updated 

The Updated symbol indicates a noteworthy change in an existing feature. 

Suite 

The Suite symbol appears next to features that only appear or function with an Entertainment Creation 
Suite license. You must license for the suite to use these features. 

Subscription 

The Subscription symbol appears next to features that appear only if you have the Entertainment 
Creation Suite Subscription Advantage Pack (SAP). To learn more about the Subscription Advantage 
Packs, visit: Autodesk M&E Subscription Advantage Packs. 

Maya to 3ds Max Interoperability Workflows 

Iterative workflows between Maya and 3ds Max can now be handled with new items found in the 
application main menus.  In Maya, a Send to 3ds Max menu item that expands to let you do the 
following: 

 Send as New [3ds Max] Scene 

 Update Current [3ds Max] Scene 

 Add to Current [3ds Max] Scene.  
 
In 3ds Max, similar options exist for sending data to and updating Maya.  These workflows are facilitated 
by FBX technology, and allows for the exchange of 3D data (meshes, UVs, Animation, etc.) 

CAT to HIK / HIK to Existing CAT 

Now, you can convert a 3ds Max CAT Biped character into a Maya (or MotionBuilder,) compatible 
HumanIK character. This compatibility allows you to transfer your character structure/definition and 
animation from 3ds Max to an FK representation on a HumanIK skeleton in Maya (or MotionBuilder).  
 

http://usa.autodesk.com/adsk/servlet/pc/index?id=14022754&siteID=123112
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Any changes or new animation that you create in Maya (or MotionBuilder) can be updated back to your 
original CAT character in 3ds Max. You can then continue to animate in the context of your 3ds Max 
scene. 
 
Note: You must have matching versions of Maya 2013 (or MotionBuilder 2013), 3ds Max 2013, and 
FBX 2013 installed to use this workflow. 

For information, see Convert CAT to HumanIK in the: 

Maya 2013 Documentation 
MotionBuilder 2013 Documentation 
3ds Max 2013 Documentation 

Remote Live Character Stream 

You can now drive your HumanIK define character (skeleton or custom rig) in Maya with a remote 
source such as motion capture data coming from MotionBuilder. Using the Live Connection window, the 
live remote source can drive your character’s skeleton in Maya directly.  
 
The new Custom Rig mapping and Live Connection window, lets you define your custom rig in Maya and 
use this mapping to stream motion capture data onto your custom Maya rig directly. 

 

Note:  You must have matching versions of Maya 2013, MotionBuilder 2013, and FBX 2013 installed to 

use this workflow. 

For information, see Live Character Streaming in the: 

Maya 2013 Documentation 
MotionBuilder 2013 Documentation 

Unified Character Context 

The previously independent Skeleton Generator, Characterization Tool, and Character Controls have 
been paired with the new Custom Rig tool in a single interface. The resulting UI streamlines your 
character setup workflows with the addition of a new Start Here pane, and a unified menu button: 

 .  
 
Separate windows have been replaced by the Skeleton, Definition, Controls, and Custom Rig tabs in the 
updated Character Controls window (Skeleton > HumanIK). Each UI and its unique toolbar change 
dynamically based upon user input entered in the Start Here pane, Character Controls menu button, or 
Source menu.  
 
For information, see Character Controls in the: 

Maya 2013 Documentation 
MotionBuilder 2013 Documentation 

http://www.autodesk.com/maya-documentation
http://autodesk.com/motionbuilder-documentation
http://autodesk.com/3dsmax-documentation
http://www.autodesk.com/maya-documentation
http://autodesk.com/motionbuilder-documentation
http://www.autodesk.com/maya-documentation
http://autodesk.com/motionbuilder-documentation
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Custom Rig Mapping 

The new Custom Rig mapping tool lets you create a custom rig mapping definition and retarget your 
animation using a UI that is similar to the Character Controls. You can create a mapping for your custom 
Maya rig using a similar click-and-assign workflow to the one that exists for skeleton definition in the 
Definition tab.  
 
For information, see Create Custom Rig Mapping in the: 

Maya 2013 Documentation 
MotionBuilder 2013 Documentation 

Align Control Rig   

Now, when you manipulate your character in Full Body or Body Part mode, the IK and FK effectors of 

your character's Control rig appear synchronized by default. This improvement visually merges the IK 

and FK solutions together to only show the final solving of the character's skeleton. This gives you a 

preview of your final animation solved on both the IK and FK rig controllers and effectors.  

You can turn Align Control Rig on and off by selecting or deselecting > Edit > Control Rig > Align 

Control Rig in the Character Controls.  

Note: Align Control Rig is not available in Selection mode.  

For information, see Align Control Rig in the: 

Maya 2013 Documentation 
MotionBuilder 2013 Documentation 

Editable Character UI 

You can customize the Character Control UI (Full Body, Hands and Feet views), as well the Custom Rig UI 
view. 

  

You can edit these UIs by modifying an externalized xml file directly. On windows, these XML files 
can be found here:  
C:\Program 
Files\Autodesk\Maya2013\resources\CharacterControls\CharacterControlsConfig.xml 
C:\Program 
Files\Autodesk\Maya2013\resources\CharacterControls\CustomRigControlsConfig.xml 

 
Here is what you can edit: 

 Background image (image resolution will define UI width) 

 Source image path 

 IK & FK cell positions  

 Extra effectors positions & directions  

http://www.autodesk.com/maya-documentation
http://autodesk.com/motionbuilder-documentation
http://www.autodesk.com/maya-documentation
http://autodesk.com/motionbuilder-documentation
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 In/back arrow positions 
 
Note: FK cell orientation and length are auto-calculated based on anchor positions. 

 

For information, see Customize the Character Layout in the: 

Maya 2013 Documentation 
MotionBuilder 2013 Documentation 

Consistent F-Curve Editor 

Animation editors in Autodesk Entertainment Creation Suites packages are now more consistent in the 
way in which function curves (F-Curves) are manipulated by the user.  

Retime Tool 

In the F-Curves toolbar, the Retime Tool lets you directly adjust the timing of key movements in your 
animations to make them occur faster or slower. For animators working in a pipeline with multiple 
Autodesk applications, similar animation retiming tools are available in some applications including 
Maya, 3ds Max, Softimage and MotionBuilder.  
 
A common task in all stages of animation is changing the timing of a motion. Performing tiny 
refinements to the timing of an animation is a repetitive and time consuming task for an animator.  
 
This provides animators with a much-needed predictable method to manipulate key moments (slower 
or faster) in an animation, as well as high-quality curves that do not require additional cleanup tasks.  
 
For information, see Retime Tool in the: 

Maya 2013 Documentation 
3ds Max 2013 Documentation 
Softimage 2013 Documentation 
MotionBuilder 2013 Documentation 

Suite Interaction Mode 

 
You can set an Interaction Mode in the 2013 Entertainment Creation Suites. Interaction mode is a set of 
hotkey/keyboard shortcuts that are consistent across all products within the Suite. This way, if you are 
familiar with one suite product, you can set a shortcut Interaction Mode that lets you use your preferred 
keyboard shortcuts for common tasks in most suite products.  
 
Interaction Mode appears as part of the Welcome screen the first time you launch any suite product.  
You can apply Interaction Mode to the current product only or to all products across the suite.   
 

http://www.autodesk.com/maya-documentation
http://autodesk.com/motionbuilder-documentation
http://www.autodesk.com/maya-documentation
http://autodesk.com/3dsmax-documentation
http://autodesk.com/softimage-documentation
http://autodesk.com/softimage-documentation
http://autodesk.com/motionbuilder-documentation
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Interaction Mode is an ongoing project for the Autodesk Entertainment Creation Suites. For the 2013 
Entertainment Creation Suites, the common shortcuts are limited to Viewport navigation and F-Curve 
hotkeys for Maya, 3ds Max, Softimage, MotionBuilder, and Mudbox. 
 
Note:  Interaction Mode applies to only keyboard shortcuts that apply to all suite products. Keyboard 
shortcuts unique to one product are not shared across the suite.  

Setting the Interaction Mode 

1. When you first launch a suite product, select Interaction Mode from the product’s welcome 

screen: 

Product Interaction Mode location 

Maya The Interaction Mode dialog appears after the splash screen. 

3ds Max The Interaction Mode dialog appears after the splash screen. 

Mudbox The Interaction Mode appears within the Mudbox Setup dialog. 

Softimage The Interaction Mode appears in the Netview dialog. 

MotionBuilder The Interaction Mode appears in the Choose your keyboard shortcuts dialog. 

2. From the Interaction Mode dialog box, choose from the list of supported keyboard 

shortcuts. (The list of available keyboard shortcuts depends on the product.) 

3. Choose to apply the shortcuts to: 

• The entire Entertainment Creation Suite family of products 

• The current product only 

If you choose Suite-wide Interaction Mode:  

• The selected keyboard shortcut mode applies to every applicable product in the 

Suite. 

• When you choose this setting, the Interaction Mode dialog no longer appears 

during the startup sequence of subsequently launched Suite products. 

If you choose product-specific Interaction Mode: 

• The selected keyboard shortcut mode is applied to the currently launched 

product only. 

 If no keyboard shortcut mode has been specified for the product, the selected 

keyboard shortcut mode dialog appears each time you launch a Suite product. 

For information on how to restore or change the default Interaction Mode, see Resetting the Interaction 
Mode. 

Resetting the Interaction Mode 

If you set an Interaction mode for a product and want to change the setting, you can restore the 
Interaction Mode for a product in the product User Interface.  
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 Maya, 3ds Max, and Mudbox users access the Interaction Mode tab through the 

Preferences dialog. 

 MotionBuilder and Softimage users access the Interaction Mode setting through 

a standalone dialog accessed through a menu.   

Autodesk product Interaction Mode UI Location 

Maya Window  >  Settings/Preferences  >  Preferences >  Interaction Mode tab. 

3ds Max Customize > Preferences > Interaction Mode tab.  

Softimage File > Interaction Mode.  

MotionBuilder Settings > Interaction Mode.  

Mudbox Customize > Preferences > Interaction Mode. 

Suite Specific Functionality 

Suite-specific functionality requires a Suite installation and a Suite License to use them. Maya must be 
installed with the Suite to have access to Live Connection or to load the Turtle plug-in.  (The Live 
Connection feature is unavailable if you installed a Maya standalone (non-Suite) version.)  
 
If there are no Suite Licenses available, you will get a licensing error even if you installed Maya with the 
Suite Installer. 

Uninstalling the Autodesk Entertainment Creation Suite Software 

Windows XP 

1. Open the Add/Remove Programs dialog in Start > Settings > Control Panel.  
2. Select the program to remove.  
3. Click on the Remove button.  
4. Click Yes to confirm the Uninstall.  

Windows 7 

1. Open Start > Control Panel > Programs > Programs and Features.  
2. Select the program to remove.  
3. Click Uninstall. 

Known Issues and Limitations 

The following are known issues and limitations of the Autodesk® Entertainment Creation Suites 2013. 

Maya 32-bit FBX Plug-in issues 

If you use the setup.exe file to install the Maya Standard, Premium or Ultimate Entertainment Creation 
Suite 2013 on a 32-bit operating system, you are not able to load the Maya FBX plug-in. This is because 
the 64-bit version of the Maya FBX plug-in is installed instead of the 32-bit version.  
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To work around this problem, select setup32.exe when installing the suite or, if you have already 
installed the suite, uninstall the FBX plug-in for Maya and reinstall the version included on your USB key. 
 
Bug Number Description 

ENCS-1703 Wrong FBX Plugin Installed on 32 bit OS with Setup.Exe in Suites 

FBXX-391 Custom attributes from 3ds Max to MotionBuilder corrupt the node and causes a crash 

ENCS-267 Mini curve editor may not have room to display the ‘move” portion of warp handles 

ENCS-313 Merging a retime-all file into the current scene does not retain retime-all values from 
incoming file 

ENCS-396 When live streaming character animation from MotionBuilder to Maya, using the vertex 
animation cache in Viewport 2.0 will cause the playback to get out of sync 

ENCS-582 Tangent handles do not move with keys when warped 

ENCS-638 Baking live character is not working when the motion is added in the Story tool 

ENCS-1011 No warning message or source menu change when overwriting a control rig with a 
custom rig 

ENCS-1029 CAT/HIK Update from Maya to 3ds Max is adding Dummies in the 3ds Max scene 

ENCS-1431 Retimers are not re-numbered when merged into a file with existing retimers 

ENCS-1507 HIK rig added to animLayer not working well in Quaternion rotation interpolation 

ENCS-1512 On first start of Maya, defining a custom rig from the menu will return a warning about 
the characterization not being valid 

ENCS-1577 Live streaming stops when switching character in the Character list 

ENCS-1591 Live bake connection breaks retargeting in Maya, if the Live character is used to retarget 
another character 

ENCS-1680 There is an issue with Mac OSX 10.7 (Lion) that prevents you installing from the USB key 

MAYA-1336 Single-Step workflow from Softimage to Maya: Nothing is received inside Maya when 
Maya is not already running 

MAYA-10869 Custom Rig mapping offsets cannot be modified when controller is added to animLayer 

SOFT-2131 ICEFlow – Send an envelope from 3ds Max to Softimage and the envelope will be 
invisible 
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